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حق نشر

شما می توانید با رعایت نکات زیر آزادانه از مطالب این کتاب استفاده کنید:

ذکر منبع را فراموش نکنید..1

چنانچه مطلبی اضافه کردید آن را نیز آزادانه در اختیار قراردهید..2

پدید آورندگان
برای این نگارش

حجت اله مداحی

برای نگارش های قبلی

شرکت دانش بنیان سامانه های آزاد فناوری اطلاعات ایده آل آینده ایرانیان )سافا(

بازخورد
 بهدر خصوص این کتاب را به طور مستقیملطفا هرگونه پیشنهادها، انتقادها و بازخوردها و نکات خود 

  ارسال فرمایید.goodlinuxuser@chmail.irرایانامه 

تاریخ انتشار و نسخه نرم افزار
۷.1 میلادی( بMMرای نسMMخه 2۰21هجری شمسMMی و 1۴۰۰)1۴۴2این راهنما همزمان با عید غدیر 

آغاز شد.

ممکن است در سایر نسخه مقداری تفاوت وجود داشته باشد.

تقدیم به سیدالشهداء، حضرت اباعبدالله الحسین و  ارواح طیبه همه شهدا که آزادگان جهانند.
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راهنمای شروع به کار با لیبره آفیس-رایتر

مقدمه



این کتاب برای چه افرادی است؟

لیبره آفیس یک مجموعه نرم افزار اداری پرکاربرد، آزاد، متن بMMاز اسMMت کMMه شMMامل چنMMدین برنامMMه
هMMای داده و فرمMMول نویسMMیپایگاه قدرتمند برای واژه پردازی، صفحات گسترده، ارائه ها، گرافیک ها ، 

است.

رایMMتر یMMک نMMرم افMMزار واژه پMMرداز اسMMت کMMه بMMا قMMالب هMMای متنMMوع از جملMMه مایکروسMMافت ورد)
doc,  .docx هMMالب ازجملMMدین قMMود را در چنMMسازگار است و شما می توانید کار خ ) .pdfروجیMMخ 

بگیرید.

 خواهMMدیافت.ارزشمندهر فردی که می خواهد به سرعت بالا در  در کار با  رایتر برسد این کتاب را  
شما ممکن است در استفاده از نرم افزار واژه پرداز تازه کار باشید یا ممکن اسMMت بMMا دیگMMر مجموعMMه

نرم افزارهای اداری آشنا باشید.

چه چیزی در این کتاب است؟

 را۷.1این کتاب ویژگی ها و امکانات اصلی رایMMتر یعMMنی بخش واژه پMMرداز از مجموعMMه لیMMبره آفیس 
معرفی می کند و دستورالعمل استفاده از آن را فراهم می سازد.

یادداشت

نسخه های برخط و دیگMMر نسMMخه هMMا نوشته شده است؛ ۷.1این کتاب برای نسخه 
ممکن است از آنچه در این کتاب توضیح داده شده است  در ظMMاهر و عملکMMرد کمی

متفاوت باشد.

۷ | چه چیزی در این کتاب است؟



لیبره آفیس را از کجا بگیرم؟

برای لینMMوکس، وینMMدوز و مکینتMMاش بMMه طMMور رایگMMان و آزاد در لیبره آفیس نسخه های مختلفی از  
در دسترس است. کاربران https://www.libreoffice.org/downloadدسترس است و از نشانی  

لینوکس همچنین نسخه متناسب با توزیع های مخلف لینوکس را خواهندیافت. در صMMفحه بMMارگیری
نسخه قابل حمل)بدون نیاز به نصب( و نسخه های دیگر فهرست شده است. 
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راهنمای شروع به کار با لیبره آفیس-رایتر

۱فصل 
آشنایی با محیط برنامه



معرفی-رایتر چیست؟

 واژه پرداز مجموعه آزاد و پر امکانات لیبره آفیس آزاد است. به عبMMارتی بMMرای  امکانMMاتبخشرایتر 
معمول یک واژه پرداز)درج متن، ویرایش و قالب بندی،صفحه آرایی، بررسMMی کننMMده دسMMتور زبMMان،

فرهنگ جامع و تصحیح خودکار؛ جستجو و جایگزینی؛ و…( رایتر امکانات فوق العاده ای دارد.

(word processor)واژه پرداز 

رم افزاری است که از آن برای ایجاد، ویرایش، صفحه آرایی و تولید صMMفحات متMMنین
استفاده می شود که البته ممکن است شامل تصاویر و اشکال گرافیکی نیز باشد.

صفحه آرایی

به آرایش متن، نحوه چیدن تصاویر، حاشیه بندی صفحات و تنظیمات چاپ، صفحه
آرایی گفته می شود.

اجزای پنجره اصلی رایتر

 نشان داده شده است که در این بخش در مورد آن توضیح داده1 شکل شماره پنجره اصلی رایتر در 
شده است.

یادداشت

به طور پیش فرض، دستورات رایتر لیبره آفیس همان طور که در این بخش توضMMیح
رایتر بMMرای دسترسMMی بMMهداده شده است در منوها و نوارابزارها گروه بندی شده اند. 

ابزارها و دستورات، هفت رابط کMMاربری  متنMMوع از جملMMه روبMMان کMMه مشMMابه آن در
viewمایکروسافت ورد وجود دارد را از طریMMق منMMوی  ...  →  User  Interface

فراهم آورده است.
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 نوار عنوان
Titleنام لاتین آن   Barاری در آنMMده جMMام پرونMMه نMMاست و در بالاترین قسمت پنجره قراردارد ک 

 را ذخMMیره نکMMردهآن تMMاکنونمشاهده می شود.در صورتی که پرونده جاری نامی نداشته باشد یعMMنی 
)بی عنوان( را مشاهده خواهید کرد.untitledباشید 

نوار منو
Menuنام لاتین آن   BarتمMMت و در سیسMMاست و جای آن در لینوکس و ویندوز زیر نوارعنوان اس  

عامل مک بالای صفحه نمایش است. موقعی که شما یکی از منوها را انتخاب می کنید یک زیرمنو باز
می شود که گزینه های بعدی را نمایش می دهد از جمله:

( درSave( یMMا ذخMMیره)Closeفرامینی  که بلافاصله عملی را انجام می دهند مانند بستن)•
(Fileمنوی پرونده)

فرامینی که پنجره های محاوره ای را باز می کنند که بMMا سMMه نقطMMه در ادامMMه فرمMMان قابMMل•
تشخیص هستند، مانند

... Find and Replace(در منوی ویرایش Edit)

فرامینی که زیرمنوهای بعدی را باز می کند. آن ها با پیکان کوچکی  مشخص هستند که در•
(. بMMاView در منMMوی نمMMا)Zoom( و Toolbarsادامه فرمان آمده است، مانند نوارابزارها)

 مکان نما روی آن ها، زیرمنو باز می شود.بردن 
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جانبینوار 
 نشان داده شده است  به طور معمول  ] بMMه1 است و همان طور شکل شماره Sidebar نام لاتین آن

طور پیش فرض در زبان های راست به چپ مانند فارسی، سمت چپ و در لاتین سمت راسMMت[  در
کنار پنجره رایتر باز است.

  در نوار ابزار می توانید آن را ظاهر یا مخفی کنید.همچنینSidebar←در صورت لزوم از منوی نما  
 دیده می شMMود، دکمMMه ای در کنMMار خMMود  بMMرای نمMMایش2نوار کناری همان طور که در شکل شماره

دادن/مخفی کردن دارد.
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(، صMMفحه)Properties دسته است: خصوصMMیات)۶نوارکناری رایتر به طور پیش فرض مشتمل برا 
Page(بک هاMMس ،)Styles(هMMنگارخان ،)GalleryاوMMبر)(، نNavigator(بکMMازرس سMMو ب ،)Style

Inspector  نوار  باز می شود. کناری( است.هر دسته با کلیک رو شمایل مربوطه 

یک تابلو ترکیبی از نMMوارابزار و پنجMMره  محMMاوره ایهر دسته شامل نوار عنوان و محتویات تابلوهاست.
است. نوارابزارها و تابلوهای نوارکناری کاربردهای زیادی به اشتراک می گذارنMMد. بMMه عنMMوان مثMMال،

( می کند  هم در نوار ابزار قالب بندی در پنجMMره اصMMلیitalic(یا مایل)Boldشمایلی که متن را توپر)
( در دسته خصوصیات.Character panelوجود دارد و هم در تابلو نویسه)

رای هماهنگ کردن عMMرض نوارکنMMاری، نشMMانگر موشMMی را دیMMواره بین فضMMای کMMاری و نوارکنMMاریب
قراردهیدو هرگاه شکل نشانگر به پیکان دو طرفه تغییر کرد، کلیک کنید و به راست یا چپ بکشMMید.
اما این کار کارایی چندانی ندارد چراکه برخی از دسته های با توجه بMMه محتویMMات آن از حMMد معیMMنی

کم عرض تر نمی شوند.
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یMا بMه شناور کنیMد از گوشه پنجره اصلی جدا کنید و به عبارت دیگر آن رابرای این که نوار کناری را 
گوشه دیگر پنجره وصل کنید از فهرست کشویی تنظیمات نوار کناری واقع در بMMالای نMMوار اسMMتفاده

 را ببینید(۳کنید.) شکل شماره

ز همیناباشMMد هم می توانیMMد فعMMال برای انتخاب این که می خواهید چه زبانه هMMایی در نوارکنMMاری 
فهرست  استفاده کنید.

جانبیدسته های نوار 
 در نوار کناری در زیر شرح داده شده است.شامل شدهدسته های 

 حاوی ابزارهایی برای قالب بندی مستقیم محتواست.(:Propertiesدسته خصوصیات)

زمانی که یک متن انتخاب شده باشد این تابلوها ظاهر می شوند::

(: اعمال، ایجاد یا به روزرسانی سبک یک بند.Stylesسبک ها)–

(:اصلاح خصوصیات متن مانند نام قلم، اندازه، رنگ، وزن یا فاصله بین نویسه ها.Characterنویسه)–

(: اصلاح ترازبندی بند، رنگ پس زمینه، تورفتگی، فاصله و شماره یا علامتگذاریParagraphبند)–
فهرست ها.

 یا گرافیک انتخاب شده باشد این تابلوها ظاهر می شوند:تصویرزمانی که یک 

اصلاح نحوه پر بودن رنگ و شفافیت پس زمینه تصویر(: Areaناحیه)–
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حالت رنگ، و شفافیت.( رنگ، contrast : اصلاح روشنایی، تضاد)(Imageصویر)ت–

 به متن دور آن.با توجه (: اصلاح موقعیت شکل یا تصویرWrap لفافه)–

دوران یا برگرداندن(:اصلاح پهنا، ارتفاع، Position and Sizeموقعیت و اندازه)–

زمانی که شی رسم شده انتخاب شده باشد این تابلوها ظاهر می شوند:

اصلاح نحوه پر بودن رنگ و شفافیت پس زمینه تصویر(: Areaناحیه)–

 هماهنگی درخشش یا لبه های نرم و شفافیت  پس زمینهیا(:افزودن Effectجلوه)–

خط: اصلاح پیکان ها، سبک خط، پهنا، رنگ و شفافیت پس زمینه–

دوران یا برگرداندن(:اصلاح پهنا، ارتفاع، Position and Sizeموقعیت و اندازه)–

زمانی یک چارچوب انتخاب شده باشد این تابلوها ظاهر می شوند:

اصلاح نحوه پر بودن رنگ و شفافیت پس زمینه تصویر(: Areaناحیه)–

دوران یا برگرداندن(:اصلاح پهنا، ارتفاع، Position and Sizeموقعیت و اندازه)–

 که  چهار تابلو دارد:صفحه استحاوی ابزارهایی برای قالب بندی مستقیم (:Pageدسته صفحه)

(:اصلاح اندازه،پهنا، ارتفاع،جهت و حاشیه های صفحه.Formatقالب)–

سبک ها: اصلاح سبک شماره گذاری صفحه، پس زمینه، چیدمان و تعداد ستون ها.–

(:فعال/غیرفعال کردن سرصفحه و اصلاح حاشیه ها، فاصله ها و محتویاتHeaderسرصفحه)–

 اصلاح حاشیه ها، فاصله ها و محتویاتپاورقی و (:فعال/غیرفعال کردن Footerپاورقی)–

احتیاط

 تغییراتی که در گزینه های دسته صفحه، شما سMMبک صMMفحه در حMMالبا آگاه باشید 
استفاده را تغییر خواهید داد، اصلاح نه فقط برای صMMفحه جMMاری بلکMMه بMMرای همMMه

صفحاتی است که در این سند از این سبک استفاده می کنند.

مدیریت سبک های استفاده شده در(: Styles and Formattingدسته سبک ها و قالب بندی)
سند، اعمال سبک های موجود، ایجاد سبک های جدید یا اصلاح آن ها.
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 نگارخانMMه. نگارخانMMه دو بخشتم هMMاینمایش تصاویر و نمودارها در (:.. Galleryدسته نگارخانه)
تم ها بر اساس نام )پیکان ها، گلوله ها، نمودارها و غیره( و دومی نمMMایشدارد: اولی فهرست هایی از 

تصاویر مربوط به تم انتخابی.

کاوش سند و تشخیص محتوای آن بر اسMMای انتخMMاب دسMMته بنMMدی(:Navigatorدسته ناوبری)
برای اطلاعات بیشتر کار بMMا نMMاوبری درمحتوا از قبیل سرفصل ها، جدول ها، قاب ها، تصاویر و غیره. 

صفحات بعد را مطالعه بفرمایید.

نمایش همه ویژگی ها سبک های بند، سبک های نویسه،(:Style Inspectorدسته بازرس سبک)
و قالب بندی دستی متن انتخاب شده.

نوارابزارها
لیبره آفیس دو نوع جایگاه نوارابزار دارد: ثابت و شناور.در حالت ثابت نوارابزارها می تواند به جاهای
مختلفی جابجا شود)مثلا بالا، پایین یا کنار فضای کاری( و حتی شبیه یک پنجره مسMMتقل،  شMMناور در

هر جای صفحه که خواستید قرارگیرند یا دوباره در قسمتی از صفحه، ثابت شوند.

آشکار یا پنهان کردن نوارابزارها
 برویMMد و روی نMMام هMMر← نم..ا نواره..ای اب..زاربرای آشکار یا پنهان کردن نوارابزارها، از نوار منو به

نوارابزاری که مدنظر دارید کلیک کنید تا با علامت دار شدن یMMا برداشMMتن علامت آن نMMوارابزار بMMه
هدف خود برسید.

برای مخفی کردن یا به اصطلاح بستن نوارابزار راه دیگری هم وجود دارد و آن کلیک راسMMت کMMردن
 که آخرینه گزینه از منویی است که باز  می بستن نوارابزارروی فضای بین دو آیکن و انتخاب گزینه

شود.

نوار ابزارهای پرکاربرد
(1در  لیبره آفیس به طور پیش فرض اولین نوارابزاری که زیر نوارمنو دیده می شMMود)شMMکل شMMماره 

نوارابزار استاندارد خوانده می شود.
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( است که اگر شکل یاFormatting toolbarدومین نوارابزار پرکاربرد در بالا نوار ابزار قالب بندی) 
تصویر انتخاب شود مخفی می شود و نوارابزار ویژگی های مربوط به تصMMویر یMMا شMMکل نمMMایش داده

می شود.

برای داشتن فضای بیشتر می توانید همان طور که قبل تر گفته شد این دو نMMوارابزار را ببندیMMد و بMMه
← نما  نوار ابزارها  جای آن از منوی ←standard(single mode) را انتخاب کنید که شامل

ابزارهای پرکاربردتر این دو نوار ابزار است.

زیرمنوها و جعبه ابزارها
شمایل های روی نوار ابزار که مثلث کوچکی کنارشان است زیرمنو یا جعبه ابزار  بیشتری مربMMوط بMMه

آن ابزار دارد.

یک جعبه ابزار  مجموعه ای از ابزارهای ضمیمه به یک ابزار است مثلا وقتی روی مثلث کوچک ابزار
شکل بزنید جعبه ابزار شامل انواع اشکال مشاهده خواهدشد. یک جعبه ابزار را همMMان طMMور کMMه در

 می بینید می توان  به عنوان یک نوار ابزار شناور باز نگه داشت. جعبه ابMMزار جMMدا شMMده نMMیز۴شکل 
دارای نوار عنوان است و  می توانید شبیه دیگر نوارابزارها آن راجابه جا یا  ثابت کنید.
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جابه جایی نوارابزارها
می توانMMد بMMه متصل در همان حMMالت هرچند می تواند از حالت ثابت خارج شود، ثابتنوارابزارهای 

 جابجا شود. چپ یا راست

برای جداکردن نوار ابزار:

 نشان داده شده5نشانگر موشی را روی دستگیره های نوارابزار ببرید)نوار عمودی کوچک ابتدای نوار ابزار که در شکل (1
است(

دکمه کلیک را پایین نگه دارید و نوار ابزار را به محل جدید بکشید.(2

دکمه موشی را رها کنید.(3

برای انتقال نوارابزار شناور-شبیه سایر پنجره ها-روی نوار عنوان کلیک کنید و به محل دیگر بکشید
یا اگر خواستید آن را به بالا یا پایین پنجره اصلی متصل کنید.

یادداشت

شما همچنین می توانید برای ثابت یا به عبMMارتی متصMMل کMMردن نMMوارابزار، روی نMMوار
عنوان آن دوبار کلیک کنید.

نکته

اگر دستگیره های نوارابزار دیده نمی شود موقعیت آن قفل شده است.برای بازکردن،
Lockقفل کردن موقعیت نوارابزار)روی آن کلیک راست کنید و سپس گزینه 

Toolbar Position).را از حالت انتخاب خارج کنید 
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خط کش ها
خط کش افقی در عرض بالای فضای کاری به طور پیش فرض مشاهده می شود اما خط کش عمMMودی

نما < خط کش ه..ا)به طور پیش فرض مخفی است. برای فعال کردن خط کش عمودی، از نوار منو، 
Rulersاب کنید ( < خط کش عم..ودیMMا از را انتخMMابزار ه..ا < گزینه ه..ا… <  ی LibreOffice

Writer > خط کش عمودی)نما ،Virtual rulerیا مخفی ( را علامت بزنید.برای به سرعت ظاهر 
 استفاده کنید.Ctrl+Shift+Rکردن هر دو خط کش از کلید ترکیبی 

نکته

دارد؛ اگMMر بMMرایود ( در انتهای خcommentsخط کش افقی یک دکمه توضیحات)
برخی بخش های سند توضیح درج شده باشد با کلیMMک روی این دکمMMه بMMه سMMرعت

قسمت توضیحات مخفی یا آشکار می شود.

نوار وضعیت
نوار وضعیت رایتر در پایان فضای کاری قرار دارد و اطلاعاتی درباره سند و راه های راحتی برای تغییر
سریع برخی ویژگی های سند فراهم می کند. این نوار می تواند از منوی نما با خارج کردن از انتخاب،

مخفی شود.

کلیدهای میانبر محیط کار
 کلید های میانبریدر لیبره آفیس هم شبیه سایر برنامه هابرای دسترسی ساده تر و سریع تر به فرامین

تا بدون نیاز به حرکت موشی بتوانید سریع تر فMMرامین مMMدنظر خMMود راهم در نظر گرفته شده است. 
(Save در لیبره آفیس و بیشتر برنامه های کMاربردی کلیMد میMانبر ذخMMیره)Ctrl+sاجرا کنید. مثلا 

است.

کلید میانبر فرامینی که در منوها مشاهده می شود رو به روی نوشته شده است.
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یادداشت

در رابط کاربری فارسی کلیدهای کنترلی صفحه کلید هم ترجمه شMMده انMMد! مثلا بMMه
Shift در نام کلیدمیانبر کلمه مهار را مشMMاهده خواهیMMد کMMرد.)بMMه جMMای Ctrlجای 

 دگرساز.Altتبدیل  و به جای 

نکته

و حرف زیرخط دار منو یا زیر منوی مربوطه می توانید بMMه آن  Alt با فشردن کلید 
  را برایFile  هم منوی F  و Altمنو دسترسی داشته باشید. مثلا فشردن  کلیدهای 

شما باز می کند و فشردن حرف زیر خط دار زیرمنوها مشMMابه کلیMMک روی آن عمMMل
خواهدکرد.

Altدر صفحه کلید استاندارد فارسی 

(Altبرای نکته قبل در هنگام فارسی بودن صفحه کلید ممکن اسMMت فقMMط دگرسMMاز)
سمت چپ کار کند چراکه در صفحه کلید استاندارد فارسی کلیدها سه حالت دارند،

( فشرده شوند که معمولا برای اعراب وShift حالتی که با تبدیل)2: حالت عادی، 1
(سMMمت راسMMتAlt حالتی کMMه بMMا دگرسMMاز)۳علایم)ویرگول و …( استفاده می شود، 

فشرده شوندکه در این حالت می توان علائم لاتین را بدون لاتین کردن صفحه کلید
ظاهر کرد یعنی بدون این که برای نوشتن@ بدون این که صفحه کلید را لاتین کنید

 را بنویسید و دوباره صفحه کلید را فارسMMی کنیMMدعلامت این 2  و عددShiftو بعد با 
 به سادگی این کار را انجام دهید.2 سمت راست و عدد Altمی توانید با 

ایجاد سند جدید خالی

شما از چندین طریق می توانید یک سند جدید یا خالی در رایتر ایجاد کنید. 
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از مرکز شروع
 (دیده می شود.۶هنگامی که لیبره آفیس باز است اما سندی باز نیست، مرکز شروع)شکل شماره

البته همان طورCreate: Writer Document روی   کلیک کنید تا یک سند متنی ایجاد شود؛ 
قالبیتا  هم  می توانید کلیک کنید Templates بیشتر توضیح داده خواهدشد روی  کمی بعد، که 

غیر از قالب پیش فرض برنامه برای سند جدیدتان انتخاب کنید.

نوار منو، نوارابزار یا صفحه کلیداز 
اگر رایتر باز باشد شما از سه راه دیگر می توانید سند جدید ایجاد کنید:

Ctrl+Nفشردن کلید ترکیبی •

 (از نوار منوFile > New > Text Document ) متنینوشتارپرونده < جدید < انتخاب •

 روی نوارابزار استاندارد(New icon جدید )کلیک روی شمایل •
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(Template موجود)الب هایایجاد سند جدید بر اساس ق

(است. قMMالب،Templateیکی از قابلیت های رایتر برای تسریع در کارهای تکراری استفاده از قالب)
 متن، قالب بندی، سبک، تصاویر پس زمینMMه ومجموعه ای از پرونده ای ویژه ای  است که  می تواند 

 قابل استفاده است)شبیهمشابه باشد و مثل یک فرم خام برای کارهای مشابه  یا تکراری سایر موارد 
قابل استفادهنامه های اداری با سربرگ مشخص(.  سبک ها و تنظیماتی است که در ایجاد سند جدید 

.مزیت استفاده از قالب برای ایجاد سMMند جدیMMد این اسMMت کMMه تنظیمMMات و طMMراحی ظMMاهریاست
سندجدید مشابه قالب انتخاب شده است و نیاز به طراحی و تنظیمات مجدد نیست.

برای بازکردن پنجره قالب ها، به این یکی از این روش ها اقدام کنید:

Ctrl+Shift+Nاستفاده از کلید میانبر  •

< File > Templates < مدیریت قالب ها از نوار منو)Templatesانتخاب پرونده < •

Manage Templates)

(File > New > Templatesانتخاب پرونده < جدید < قالب ها از نوار منو)•

( روی نMMوارابزار اسMMتاندارد وNew iconکلیMMک روی مثلث کوچMMک شMMمایل جدیMMد)•
Templatesانتخاب  ...

 قالب های مربوط به نوشتار)سندهای های متMMنی( مشMMخص۷نمونه نشان داده شده در شکل شماره
است. کافیست روی قالب دلخواهتان دوبار کلیک کنید تا سندی با آن قالب ایجاد شMMود. همچMMنین

 کلیک کنید.(Openبازکردن)می توانید یک قالب انتخاب کنید و روی دکمه 
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مدیریت اسناد

پس از اسند جدید و تکمیل آن، لازم است یجاد یک اسنادی که در سند را ذخیره کنیم یMMا ببنMMدیم.
همچنین ممکن است در آینده بخواهیم مجددا نوشتار را در رایتر باز کنیم.

ذخیره کردن سند
Save ذخ..یره ب..ا عن..وان...) یا فرمان(Save ذخیره)شما می توانید یک نوشتار را با فرامین  as)

ذخیره کنید.
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فرامین ذخیره سازی

ذخیره پرونده جدید یا پرونده از قبل ذخیره شده
یکی از کارهای زیر را انجام دهید:

.Ctrl+Sفشردن •

(File > Save از نوار منو) پرونده < ذخیرهانتخاب•

 ( روی نوارابزار استاندارد.Save icon)ذخیرهکلیک روی شمایل •

نکرده باشید، با انجام هر یک از گزینه های فوق، پنجره ذخیره به عنوان) نوشتار جدیدتان ذخیره  اگر
Save  asازی آن راMMیره سMM( باز می شود. نامی برای پرونده وارد کنیدو از نوع)پسوند( و محل ذخ

 کلیک کنید.ذخیرهبازبینی کنید و روی 

پس از این که سند را ذخیره کردیم، ممکن است مجددا تغییراتی را در آن اعمال کنیم. بهMMتر اسMMت
چر چند دقیقه  یکبارسند را ذخیره کنیم تا در صورت ایجاد مشکلی مانند قطع شدن برق، تغیMMیرات

داده شده از بین نرود.

برای ذخیره پرونده جاری نیز به همان ترتیب گفته شده عمل می کنیم:

.Ctrl+Sفشردن •

(File > Save از نوار منو) پرونده < ذخیرهانتخاب•

 ( روی نوارابزار استاندارد.Save icon)ذخیره کلیک روی شمایل •

بدیهی است اگر نوشتار را از قبل ذخیره کرده باشید پس از انجام هر یک از گزینه های بالا، برای نMMام
 نیست و پرونده با همان نام و نوع در همMان محMل فعلیاضافه تریو نوع و محل پرونده نیاز به کار 

ذخیره خواهدشد.

پرونده جاری

سندی  که هم اکنون در داخل آن قرار داریم و نام آن در نوار عنMMوان)بMMالای پنجMMره(
مشخص است را پرونده جاری می گوییم
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(Save a copyذخیره یک رونوشت)
وقتی استفاده کنید که می خواهید سند فعلی باز بماند و و رونوشMMت جداگانMMه ای هم ازاز این دستور 

نگارش فعلی ذخیره کنید.

Save As را که انتخاب کردید، پنجره محاوره ای Save a Copyوقتی از نوار منو،  پرونده <  ...

ظاهرشد، نام، نوع و محل را وارد یا تایید کنید و سپس روی ذخیره کلیک کنیMMد. رونوشMMت ذخMMیره
شده باز نمی شود و پرونده اصلی باز و فعال باقی  می ماند.

ذخیره همه
این فرمان همه پرونده های باز را ذخیره می کند.

را انتخاب کنید تا بدون تغییر در نام، نوع یا( File > Save All پرونده < ذخیره همه)از نوار منو،
محل ذخیره سازی همه پرونده های باز  ذخیره شوند.

(Save asذخیره به عنوان )
 جدید با نام یا نوع یا محل ذخیرهسندی فعلی را به عنوان نگارش گاهی اوقات ممکن است بخواهیم

سازی دیگری ذخیره کنیم. برای این کار به صورت زیر عمل می کنیم:

File پرونده < ذخیره به عنوان)از نوار منو،   >  Save  As )انبرMد میMدیا کلیMاب کنیMرا انتخ
Ctrl+Shift+S را بزنید تا پنجره ذخیره باز شود، سپس نام یا نوع یا محل جدید را مشخص کنید و

در نهایت روی ذخیره کلیک کنید.

(Save as ) و ذخیره به عنوان(Save a copy)فرق ذخیره رونوشت

وقتی ذخیره به عنوان را انتخاب می کنید نگارش فعلی جداگانه ذخیره خواهد شد با
این تفاوت که پرونده اصلی با آخرین ذخیره سازی قبلی بسته می شود و سندی که باز
است در واقع سند جدید ذخیره شده است.اما در ذخیره یک رونوشت همان طور که
گفته شد تغییرات تا آن لحظه در پرونده ای دیگر ذخیره می شود بMMدون این کMMه بMMاز

شود و شما می توانید ادامه تغییرات را شما در پرونده اصلی انجام  دهید.
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یادداشت

PDFلیبره آفیس از عبارت »صدور« برای خروجی گرفتن در قالب های دیگر ماننMMد 

 استفاده می کند.ePubو 

بازکردن سند
 از چندین راه می توانیم اسناد موجود را باز کنیم، از جمله:

 از مرکز شروعRemote files ا  یOpen File  کلیک روی •

 از نوار منو.File > Open Remote یا ( File > Open.)   پرونده < بازکردن..انتخاب•

.Ctrl+Oفشردن  •

روی نوار ابزار استاندارد.( Open iconکلیک روی شمایل بازکردن)

 را مشMMخص می کMMنیم ودر صورت نیاز محل و نوع پرونMMدهد، ابتدا شهنگامی که پنجره بازکردن باز
 کلیک می کنیم. بازکردنسپس پرونده مورد را انتخاب و در نهایت روی دکمه 

برای باز کردن سندیی که اخیرا در رایتر باز شده باشد روش های ساده تری هم هست:

کلیک روی تصویر بند انگشتی سند نظر را در صفحه شروع•

 < از نوار منو و انتخاب سند مورد نظرپرونده < بازکردن نوشتار های اخیرانتخاب •

( روی نوار ابزار استاندارد.Open iconکلیک روی مثل کوچک روبه پایین کنارشمایل بازکردن)•

(Switch Windowsتعویض پنجره فعال یا پرونده جاری)
همان طور که می دانید فقط یک پرونده جاری می توانیم داشته باشMMیم یعMMنی همزمMMان نمی تMMوانیم

 توانیم از منMMویمی چندین سند باز نیازمند ویرایش باشد  مشغول نوشتن در چندسند باشیم.اما اگر
در نوارمنو، فهرست پنجره های باز را ببنیم و سند مورد نظر خود را انتخMMاب کMMنیم تMMا پنجMMرهپنجره 

فعال ما شود.

بستن سند
برای بستن پرونده جاری یکی از روش های زیر را به کار می بریم:
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 را انتخاب می کنیم.بستناز نوار منو، •

  را می فشاریم.Ctrl+wیا کلید میانبر •

  را می فشاریم.Alt+F4یا کلید میانبر •

  روی نوار عنوان کلیک می کنیم.Xیا روی  دکمه کنترلی  •

 را انتخاب می کنیم.بستننوار عنوان کلیک راست می کنیم و از منوی ظاهرشده یا بر روی •

 کMMه میگر تغییرات داده شده را ذخیره نشده باشد، در هنگام بستن پرونده، اخطاری داده می شMMودا
کلیک کنید.ذخیره یا عدم ذخیره یا انصراف از بسته شدن پرونده توانید روی دکمه 

2۷ | مدیریت اسناد



راهنمای شروع به کار با لیبره آفیس-رایتر

۲فصل 
ویرایش سند



 روش های نمایش سند

رایتر سه شیوه کلی برای نمایش و ویرایش یک سند دارد: عادی، وب و تمام صفحه. برای تغییر نما،
از منوی نما روی نمایی که نیاز داریم کلیک می کنیم.

نما یا در واقع پیش نمایش چاپ هم نمای دیگری است که البته غیرقابل ویرایش است که می تMMوانیم
( فعال کنیم.File > Print Preview)آن را از پرونده < پیش نمایش چاپ

(Normal viewنمای عادی)
نمای عادی، نمای پیش فرض رایتر است که سند را همان طور که قرار است چاپ یا پی دی اف شود

نشان می دهد.

می توانیم سرصفحه و پاورقی و سایر فضMMاهای خMMالی بین صMMفحات رادر نمای عادی در صورت نیاز 
از نوار منو برداشته  Show Whitespace نما <  مخفی کنیم؛ برای این کار علامت انتخاب از

شود.

نکته

Single-pageنمای تک صفحه ای)  ViewدازهMMه انMMه بMMا توجMMچند صفحه ای ب ،)
Multiple-pageصفحه نمایش و بزرگنمMMایی فضMMای کMMاری )  View(ابیMMو کت )

Book Viewه رویMMمایل مربوطMMهم نماهای عادی هستند که با کلیک روی ش )
نوار وضعیت در کنار ابزار بزرگنمایی قابل استفاده هستند.

نمای وب
 آن را در مرورگر اینترنتی در حال مشاهده هستیم. گویانمای وب سند را آن طور نشان می دهد که 
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نمای تمام صفحه
در این نما، نوار ابزارها و نوارجانبی وجود ندارد؛ سند تمام ناحیMMه را پMMر می کنMMدو البتMMه  بMMر اسMMاس

تمMMام صMMفحه ازبزرگنمایی  و چیدمانی که در نمای عادی انتخاب شده بMMود. بMMرای رفتن بMMه نمMMای 
  کلیMMدیا برای خروج از این نما هم می توانیم می کنیم و  استفاده  Ctrl+Shift+Jکلیدهای  میانبر 

Esc.را بفشاریم یا کلیدها را یک بار دیگر بفشاریم  

انتخاب کردن متن

برای انجام کارهای ویرایشی بر روی متن، لازم است ابتدا متن مورد نظر را با موشی یا صMMفحه کلیMMد
انتخاب کنیم.

انتخاب متن

(قسمتی از متن برای ویرایش، قالب بندیHighlight کردن)رجسته یا درخشانبه ب
یا رونوشت گرفتن و … از آن، انتخاب کردن متن می گوییم.

(paragraphبند)

  از هم جدانشده اند، بند می گوییم.Enterبه عبارات یا جملات پشت سر هم که با 
به عبارت ساده با نقطه سرخط یک بند به پایان می رسد.

 انتخاب متن در رایتر شبیه انتخاب متن در دیگر برنامه های کMMاربردی اسMMت. می تMMوانیم نشMMانگر
 مورد نظر ببریم و چندبار کلیک کنیم برای انتخاب یک کلمه)دوبار کلیک(، یMMکمتنموشی را روی 

جمله)سه بار کلیک( و یک بند)چهاربار کلیک(.

 و هم استفاده کنید.ctrl و shiftباز هم شبیه انتخاب در برنامه های دیگر می توانیم از کلیدهای 

جMMایی  را نگهداشته ایم به کمک کلیدهای جهتی)بالا-پایین-چپ-راست( یا اگMMر shift وقتی دکمه 
همچMMنین مMMادیگری از متن کلیک کنیم فاصله بین کلیک جدید و محMMل قبلی انتخMMاب خواهدشMMد.

افزایش استفاده کنیم تا با کلیک محدوده انتخاب را shift به جای نگه داشتن f8می توانیم از کلیک 
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Extended  حالت انتخاب در واقع به حالت انتخMاب افزایشMی)f8دهیم. با   selectionدیلMتب)
 دوباره، حالت انتخاب را به حالت استاندارد انتخاب بر می گرداند.f8می شود و 

 را۸یک راه برای تغییر حالت های انتخاب استفاده از شمایل مربوطه در نوار وضعیت اسMMت.)شMMکل 
ببینید(. موقعی کMه روی آن کلیMک راسMت کMنیم منMویی بMاز می شMود کMه گزینه هMای مختلفی در

  عمMMلshift کMMه مشMMابه  f8دسترسمان قرار می دهد.انتخاب استاندارد، انتخMMاب افزایشMMی)کلیMMد 
( و انتخMاب بلMوکی) عم@@ل می کندctrl مش@ابه نگ@@ه داش@@تن Shift+F8می کرد، انتخMاب اضMافه)

Ctrl+Shift+F8که  به ما امکان انتخاب متن  چند نویسه یا کلمه از ابتدا، میانه ی@@ا انته@@ای چن@@د 
خط می دهد(

غیر پیوسته قسمت هاانتخاب 
 پس از انتخاب اولین قطعه متن به کمک موشی،۹برای انتخاب قسمت های غیرپیوسته شبیه شکل 

Ctrl را پایین نگه می داریم و  قطعه متنی دیگر را انتخاب می کنیم. به جای نگMMه داشMMتن ctrlدکمه 

م تا چند متن را بتوانیم همزمان انتخاب کنیم. استفاده کنیShift+F8 هم می توانیم از  
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Addnig حالت انتخاب کردن از استاندارد به حالت انتخاب اضMMافه)Shift+F8با    Selection)
تغییر خواهد کرد و فشردن مجدد آن انتخاب را به حالت استاندارد برمی گرداند.

انتخاب بلوک عمودی متن
از حالت انتخابی بلوکی رایتر می توانیم بلوکی از متن ها را از چند چند سطر انتخاب کنیم. بMMرای این

selectionوایریش < کار می توانیم از منوی   modeمارهMMشکل ش(د۸ یا نوار وضعیتMMا کلیMMی  )
  وshift، با کمک موشMMی یMMا 1۰ حالت بلوکی را انتخاب کنید و شبیه شکل ctrl+shift+f8ترکیبی 

دکمه های جهتی صفحه کلید بلوکی از  متن را انتخاب کنید.
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 متنسباندنبرش، رونوشت و چ
بریدن و رونوشت متن در رایتر شبیه برش و رونوشت متن در برنامه های دیگر است. مMMا می تMMوانیم
متن انتخاب شده ای را با کشیدن با موشی، کلیک راست، شمایل مربوطMMه یMMا کلیMMدهای میMMانبر  در
داخل سند یا بین اسناد رونوشت یا جابجا کنیم. همچنین می توانیم از دیگر منابع مثل صفحات وب

متنی را رونوشت بگیریم و آن را در سند رایتر بچسبانیم.

 جدید بکشید و رها کنید.محل موشی استفاده کنید و آن را به از )کشیدن و رها کردن(ابجایی متن انتخاب شدهبرای ج•

 نگهدارید.هم را در Ctrlبرای رونوشت متن انتخاب شده، ضمن کشیدن، کلید •

 را  برای بریدن متن استفاده می کنیمCtrl+X)بریدن و جایگذاری در محل جدید(، برای جابجایی متن انتخاب شده•
 متنچسqqباندن بqqرای Ctrl+Vو سپس مکان نما را در نقطه ای که قرار است جای گذاری کqqنیم قqqرار می دهیم  و از 

استفاده کنید. روش دیگر استفاده از دکمه های نوارابزار است.

( استفاده می کنیم قالب و سMMبک مبMMدا)مثلا نMMوع و انMMدازهpasteوقتی به طور معمول از چسباندن)
قلم( هم حفظ می شود.
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می دهیم( را بMهبرای اینکه متن جابجا شده، قالب بندی و سبک متن مقصد)جایی که در آن جMا قMMرار 
:خود بگیرد

 را انتخاب می کنیم یاPaste Specialاز ویرایش <  •

 نوار ابزار  کلیک می کنیم یا( Paste Iconچسباندن) مثلث کوچک کنارروی •

 تازیرمنوها دیده شود یا می داریمکلیک موشی را نگه  چسباندن، از نوار ابزار روی شمایل•

•Ctrl+Shift+V.را می زنیم  

.می کنیم( را از منو نتایج انتخاب Unformatted text )بدون قالب متن سپس

نکته

بچسبانیم.  Ctrl+Alt+Shift+Vمی توانیم متن را بدون قالب مبدا، در مقصد با زدن  

جستجو و جایگزینی متن

 برای اولین روش بMMرای جسMتجو اسMتفاده از نMوارابزار برای جستجوی متن در سند دو راه دارد:رایتر
 است. Find & Replace( است و روش دیگر استفاده از پنجره محاوره ای Find)جستجو

جستجو استفاده از نوارابزار 
پنجMMره برنامه مشاهده می شود، پایین 11به طور پیش فرض نوارابزار جستجو، همان طور که در شکل

 توضMMیح داده شMد امکMان1)درست بالای نوار وضعیت( مشMاهده می شMMود؛ همMانطور کMه در فصل
اگر این نوار ابزار را نمی بینید نگMMران نباشMMید می تMMوان آن را از. وجودداردجابجایی و شناور کردن آن 

 ظاهرکرد.Ctrl+F  یا (View > Toolbars > Findنما < نوارابزارها < جستجو )منوی 
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 بMMزنیم. ازEnter ورودی بنویسMMیم و کMMادر افیسMMت آن را در ، ک متن یا عبارت متنیبرای جستجو
 نیز می توانیم آن را اگر در موقعیتFind Previous یا Find Nextهای بالا و پایین  طریق دکمه

( نشان می دهد.Highlight هم همه یافته ها را برجسته)Find Allهای قبلی یا بعدی پیدا کنیم. 

خفی کردن این نوار ابزار  چندین راه دارد از جمله:م

 ابتدای نوار ابزارX دکمهکلیک روی •

 در زمانی که در کادر جستجو قرار داریمEscزدن •

 Find & Replaceاستفاده از پنجره محاوره ای  

( از روش های زیر اقدام می کنیم:12شکل   )Find & Replaceبرای نمایش کادر محاوره ای 

 Ctrl+Hکلیدهای میانبر •

.می کنیمرا از از نوارمنو انتخاب  Edit > Find & Replace ویرایش <...•

 روی نوارابزار جستجو Find & Replaceکلیک روی دکمه  •
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Otherهنگام باز بودن این کادر محاوره ای روی این اختیار را داریم که   OptionsاMMکلیک کنیم ی 
(را ببینید 12شکل ). امکانات جستجو را گسترش دهیم

برای استفاده از کارد محاوره ای جستجو و جایگزینی به ترتیب زیر عمل می کنیم:

 می نویسیمFindمتنی که می خواهیم جستجو کنیم را در کادر (1

 می نویسیمReplaceبرای جایگزینی آن متن با متنی دیگر، متن جدید را در کادر (2

)match case. مانند می کنیم گزینه های مختلفی را انتخاب ر صورت نیازد(3  بزرگی یqqا کqqوچکی حqqروفتطابق با 
 کل کلمات یعنی متن مورد جستجو جزیی از یک کلمه نباشد مثلافقط )whole words onlyانگلیسی( یا  

اگر دنبال کلمه »دانش آمqوز«  هسqتیم دانش آمqqوز در کلمqqاتی ماننqqد»دانش آمqqوزان«، »دانش آموزهqqا« یqqافت نشqqود(.
: جستجو فقqqط در متن انتخqqاب شqqده، جسqqتجو از مqqوقعیت فعلیمثلهمچنین گزینه های دیگر هم  در دسترس است 

. سندمکان نما به عقب به سمت ابتدای 

یادداشت

در مثال جستجوی »دانش آموز« فقط در کلمات کامل، اگر »دانش آموزها« با فاصله
بین دانش آموز و ها به صورت »دانش آموز ها« نوشته شده باشد کلمMMه دانش آمMMوز

کلمه کامل و جدا از کلمه بعدی به نظر خواهد رسید و در نتایج خواهد آمد.

داده خواهدشqqد و در نمqqایش اگر نتیجه ای یافت شqqود بqqه صqqورت برجسqqته، می کنیم کلیک Find Next بر روی (4
 متن جدید جایگزین کنید.Replace با کلیک کردن بر روی صورت نیاز به جایگزینی

نکته

Replaceاز نیاز به مشاهده موردی نتایج نداریم با کلیک روی    AllاMMهمه نتایج ب 
متن موردنظرمان جایگزین خواهد شد.

هشدار

 باید با احتیاط و دقت و اطمینان استفاده کنیم چراکه اگر سند راReplace Allاز  
ذخیره  و بسته شود؛ دیگر قابل بازگشت به حالت قبل نخواهدبود.
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درج نویسه های ویژه

 ¢M¾ M© æ ç Ł ñ ö ø نویسه های ویژه مواردی است که در صفحه کلید پیدایشان نمی کنیم مثلا
. همگی نویسه های ویژه هستند

برای درج یک یا چند نویسه ویژه، نشانگر را در موقعیتی که می خواهیم نویسه ها ظاهر شMMوند قMMرار
می دهیم و به یکی از روش های زیر اقدام می کنیم:

Special نویسه ویژه)روی شمایل•  Character )تی ازqqنیم تافهرسqqک می کqqتاندارد کلیqqروی نوارابزار اس 
را13نویسه های برگزیده یا اخرا استفاده شده باز شود و برای درج، روی هر کدام که خواستیم کلیک می کنیم) شqqکل 

 کqqادرMore Characters(.همچنین می توانیم در انتهqqای فهرسqqت بازشqqده،  بqqا کلیqqک روی دکمqqه  ببینید
( را بازکنیم.14محاوره ای نویسه های ویژه)شکل

Insert درج < ... کلیqqک روی منqqوی•  > Special  Character  دنqqاز  شqqرای بqqاوره ای بqqادر محqqک
( و سپس دوبار کلیک روی نویسه هایی ]از هر قلم یا ترکیبی از قلم هqqا[ کqqه  می خqqواهیم درج14نویسه های ویژه)شکل

شود. نویسه هایی که انتخاب کردیم در سند درج می شود و همچنین به فهرست نویسه های اخیرا استفاده شqqده اضqqافه
می شوند.

 نویسه های ویژه مختلف هستند. اگر نویسه ویژه به خصوصی را پیدا نکردیمشاملقلم های مختلف 
را باید امتحان کنیم.لازم است قلم های دیگر 
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نکته

 برای مشاهده جزییات نویسه یک بار روی آن کلیک می کنیم تا جزییات آن از جمله
کدعددی آن مشاهده شود.

با دوبار کلیک روی نویسه مد نظر، نویسه مدنظر درج می شMMود و کMMادر محMMاوره ای
نویسه های ویژه همچنان باز می ماند. اما اگر روی نویسه مدنظر ]یMMک بMMار[ کلیMMک

 را بزنیم؛ نویسه درج و پنجره بسته می شود.Insertکنیم و سپس دکمه 

راهنمای شروع به کار۷.1لیبره آفیس  | 38

: کادر محاوره ای نویسه های ویژه۱۴شکل 



راهنمای شروع به کار با لیبره آفیس-رایتر

۳فصل 
قالب بندی



مقدمه

وقتی یک متن ساده را در رایتر می نویسیم ممکن است از لحاظ ظاهری زیبMMا بMMه نظMMر نرسMMد و لازم
است به کمک قالب بندی، ظاهر متن را به گونه ای تغییر دهیم تا زییایی و خوانایی مورد نیاز را داشته

باشد. این فصل، اصول قالب بندی متن در رایتر را پوشش می دهد، مفاهیمی از قبیل:

قالب بندی بندها و نویسه ها•

قالب بندی دستی و سبک ها•

استفاده از قالب بندی خودکار•

ایجاد فهرست های گلوله ای، شماره دار یا طرحواره ای•

 توضMMیح داده شMMده اسMMت،2در این فصل فرض بر این است که با تکنیک هMMای متMMنی کMMه در فصل
آشنایی داریم.

قالب بندی نویسه ها

ما می توانیم بعد از انتخاب متن)نویسه های( مورد نظر، قالب های متعMMددی بMMه آن  اعمMMال کMMنیم.
مهم ترین ابزار های قالب بندی نویسه ها از طریق دکمه های نوارابزار قالب بندی  و با استفاده از پانMMل

نویسه ها در دسته خصوصیات نوار جانبی در دسترس هستند از جمله:

( و اندازه و جلوه های آنFont قلم)نوع•

(، زیرخط دار و…(Italic(، کج)Boldسبک نگارش قلم )توپر)•

رنگ قلم و پس زمینه آن•

نوع قلم، اندازه و جلوه ها
 را از راه های زیر می توانیم تغییر دهیم:نوع، اندازه، رنگ و جلوه ها و سایر ویژگی های قلم

 نوارابزار قالب بندیفهرست های کشویی قلم و اندازه و سایر دکمه های دراز  •

با استفاده از پانل نویسه ها در دسته خصوصیات نوار جانبی •
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پنجره محاوره ای قلم•

 قلم غیر از کشوی فهرست اندازه قلم روی نMMوارابزار قالب بنMMدی، راه افزایش یا کاهش اندازهبرای
دکمه افMMزایش و کMMاهش انMMدازه قلم کلیMMکدیگری نیز وجود دارد؛ می توانید از پانل نویسه ها روی 

( تغییر می دهد.Point نقطه)2کنید که معمولا اندازه قلم را 

(Pointنقطه)

 اینچ1/۷2هر نقطه برابر است با 

تنظیمات روی محاوره  نویسه
( دارد.کMMه در این بخش نشMMان دادهtab( شMMش صMMفحک)زبانMMه یاcharacter نویسMMه)محMMاوره

می شود.برای باز کردن محاوره نویسه چندین راه وجود دارد:

 از روی نوار منو  Format > character قالب بندی < ... کلیک روی منوی•

character  از زیرمنوی characterکلیک راست روی متن انتخابی و انتخاب  ... •

 بازاست.Properties  نوار جانب، وقتی دسته Character پانل More Optionsکلیک روی چرخنده •

قلم، انداز، رنگ و جلوه های قلم
ج(، عMMادی، تMMوپر، کشامل قلم، سبک)حالت های مختلف قلم نام( می توانیم 1۵)شکل قلم زبانهدر 

 آن را مشخص کنیم.اندازه و زبان

  موارد مربوطCTL Font موارد مربوط به زبان لاتین و از قسمت western Text Fontقسمت 
به زبان فارسی را تنظیم می کنیم.

( نیز می توانیم رنگ قلم و طیفی از جلوه ها را انتخاب کMMنیم کMMه البتMMه1۶)شکل جلوه های قلماز زبانه
برای مستندات رسمی چندان مناسب نیستند.
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موقعیت
در زبانه موقعیت می توانیم موقعیت نویسه ها را مشخص کنیم به این معنا که:1۷مطابق با شکل 
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 محاوره نویسهاز قلم زبانه: ۱۵شکل 

: زبانه جلوه های قلم از محاوره نویسه۱۶شکل 



 اندیس هستند چند درصد اندازه قلم اصلی باشند.گر و اپایین  یا اندیس بالا یا اندیس باشندعادی •

 درجه باشند یا به عبارت دیگر عمودی باشند یا افقی) 2۷0 یا 90، 0دارای زاویه •

دی
(عمو

فاصله بین نویسه های وجود داشته باشد•

(HyperLinkفراپیویند)
 کلیMMکبازبانه فراپیوند این امکان را با ما می دهد نشانی اینترنتی یا پرونده ای را مشخص کMMنیم تMMا 

آن پرونده یا صفحه اینترنتی باز شود.روی نویسه های انتخاب شده،  

(HighLight)سازیبرجسته 
زبان برجسته کردن می توانیم شبیه ماژیک های فسفری، نویسه های مدنظرمان را با رنگی دلخواه،از 

برجسته کنیم، همان طور که قبلا هم گفته شد، انجام این کار از نوارابزار قالب بندی و نوار جMMانبی هم
امکان پذیر است)دکمه کنار رنگ قلم(

43 | قالب بندی نویسه ها

: زبانه موقعیت از محاوره نویسه۱۷شکل 



حاشیه ها
آخرین زبانه هم برای این که دور نویسه های خود به ترتیبی که مMMدنظر داریم، حاشMMیه ای بMMا جلMMوه

مدنظر خودمان اضافه کنیم. در مورد حاشیه ها در قسمت بندها توضیح بیشتر ارائه خواهد شد. 

قالب بندی بندها

برای قالب بندی بند نیاز به انتخاب بند نیست و تنها کافیست مکان نما در بند باشد. البته اگر چند
بند را بخواهیم همزمان قالب بندی کنیم باز هم لازم است ابتدا حداقل بخشMی از هMر دو را انتخMاب

 می توانیم قالب های مختلفی را به بندها اعمال کنیم، مثلا با استفاده از:کرده باشیم.ما

شمایل روی نوار ابزار قالب بندی•

  نوار جانبیProperties از دسته Paragraphپانل •

 منوی قالب بندی نوار منودردستورات موجود •

گزینه های موجود در محاوره بند•

 دربند از طریق دکمه های نوارابزار قالب بندی  و با استفاده از پانل بندمهم ترین ابزار های قالب بندی 
دسته خصوصیات نوار جانبی در دسترس هستند.

 دکمه ها و شمایل مربوط به بند معرفی شده اند.1۸در زیر شکل

ترازبندی بند
ترازبندی یا چینش که در اینجا منظور تراز بودن خطوط مد نظر است را با مثال توضیح خواهیم داد.

وقتی می گوییم این بند راست چنین است یا از راست تراز شده است منظور این است که فاصله همه
اولین کلمات آن بند از حاشیه سمت راست یکسان است.

که مشابه آن در نوار قالب بنMMدی وجMMود دارد بMMرای ترازبنMMدی1۸ شکل ۴ تا 1ما می توانیم از دکمه 
استفاده کنیم.شکل نمونه های از اعمال ترازبندی به متن را به شما نمایش می دهد.
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تورفتگی از چپ۱۵افزاش فاصله با بند بعدی و قبلی۸چپ چین)تراز چپ(۱

تورفتگی از راست۱۶کاهش فاصله با بند بعدی و قبلی۹وسط چین۲

تورفتگی اولین خط۱۷افزایش تورفتگی۱۰راست چین۳

فاصله خطوط۱۸کاهش تورفتگی۱۱تراز از دو طرف۴

گزینه های بیشتر از طریق باز شدن۱۲Hanging Indent۱۹گلوله ها۵
محاوره مربوطه فاصله قبل از بند۱۳شماره گذاری۶

فاصله بعد از بند۱۴رنگ پس زمینه۷

: پانل های سبک و بند از دسته خصوصیات روی نوار جانبی۱۸شکل 

متن راست چین یا از ترازشده از راست.
متن وسط چین

متن چپ چین یا ترازشده از چپ
(بین کلمات هر خط در صورتی که کل خط را پرنکنند، فاصله هایی درج می کند یاJustifiedمتن هم تراز شده)

در فارسی برخی کلمات کشیMMMده تر می کند تا فاصله ابتدای اولین کلمه از حاشMMیه راسMMت و آخMMرین کلمMMه از
حاشیه چپ، در خطوط ماقبل آخر یکسان باشد.

: گزینه های ترازبندی متن۱۹شکل 
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یادداشت

خط اول و آخر هر بند گاهی در ترازبندی استثنا می شMMوند. بMMه عبMMارتی گMMاهی بMMرای
زیبایی متن خط اول هر بند را تورفته می کنیم و خط آخر بMMرای این کMMه ممکن اسMMت

نیاز به فاصله و کشیدگی زیاد داشته باشد هم تراز با سایر خطوط نمی شود.

تنظیم فاصله بین خطوط و بندها
 مشMMاهده می شMMود، همMMان طMMور کMMه از نMMام آن1۸ شکل 1۸فاصله بین خطوط که در دکمه شماره 

پیداست فاصله بین خط زمینه دو خط است.

( است؛ بدیهی است با بیشتر کMMردن این مقMMدار،single)1به طور پیش فرض فاصله خطوط از هم 
فاصله خطوط از هم بیشتر و بالتبع تعداد خط در یک صفحه کم تر خواهد شد. مثلا اگر این فاصله را

.شده است)دوبرابر( قراردهیم انگار یک خط در میان نوشته 2

 دیده1۸فاصله بند اشاره دارد به فاصله عمودی بند با بند قبلی و بعدی، که همان طور که در شکل 
 قابل تنظیم است.البته اگر بخواهیم فاصله بند از بند قبلی متفاوت۹ و ۸می شود از طریق دکمه های 

 نشMMان1۴ و 1۳ با شماره 1۸از فاصله آن با بند بعدی باشد؛ مقدار مورد نظر را  قسمتی که در شکل 
داده شده، ثبت می کنیم.

تورفتگی
برای تورفتگی یا کنگره ای کردن متن در جهت زیبایی و خوانایی بیشتر متن، می توانیم از دکمه هMMایی

 بین حاشMMیه صMMفحه و خطMMوط بنMMد رافاصله خورده است، مقدار 11 و 1۰ برچسب 1۸که در شکل 
افزایش و در صورت نیاز دوباره کاهش دهیم.

 در همان شکل نیز می توانیم فاصله حاشیه از ابتدا یا1۶ و 1۵از تنظیمات مشخص شده با برچسب 
 هم مشخص کننده تنظیمات تورفتگی صرفا بMMرای1۷انتهای خطوط را نیز مشخص کنیم. برچسب 

اولین خط است.
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 را تغییر می دهد؛ بدین معنا که به جای تورفتگی خMMط اول، سMایرتو رفتگی خط اول کارایی 12دکمه  
خطوط غیر از خط اول شامل افزایش یا کاهش تورفتگی خواهندشد.

این بند نمونه ای است از تورفتگی خط اول بند است کMMه در بنMMدهای کتاب هMMا معمMMول
است. در بند بعدی نمونه ای از حالت برعکس آن خواهید دید.

hangingاین بند هم نمونه ای اسMMت از بنMMد بMMا تMMورفتگی همMMه خطMMوط غMMیر از خMMط اول)

indentتورفتگی غیر خط اول اغلب برای شماره گذاری بندها، یا قرار دادن شمایل یا .)
تصویری در ابتدای خط اول استفاده می شود تا شماره یا تصویر موجب تورفتگی ظMMاهری

خط اول نشود

رنگ پس زمینه بند
 نشMMان۷ چسب  با بر1۸شکل پس زمینه بند رنگی باشد می توانیم روی دکمه ای که در برای این که 

داده شده، کلیک می کنیم تا جعبه رنگ باز شود، یک رنگ انتخاب کنیم. اگر رنگ مورد نظرمMMان در
 رنگی سفارشی و دلخواه انتخاب می کنیم.رنگ هایی که اخیراCustom Colorجعبه رنگی نبود از  

 مشاهده می شود.Recentدر این قسمت یا سایر قسمت های برنامه استفاده شده است، در قسمت 
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نکته

, مانند این کتاب مورد استفاده قMMراررایانه ایفاصله گذاری بند اغلب در مستندسازی 
 معمولًا در سایر اسناد مورد استفاده قرار می گیرد. برای طراحیتورفتگی بندمی گیرد. 

 از فاصله بند یا تو رفتگی استفاده کنید اما هرگز هر دو با هم استفاده نکنید.،خوب

تنظیمات روی محاورهٔ بند
  کMMه درصMMفحه پMMرش هMMاTabs بند شامل چندین زبانMMه اسMMت: پرش هMMا)

(، نویسه های بزرگ سMMربند)Bordersتوضیح آن آمده است.(، حاشیه ها)
drop  caps(هMMناحی ،)دMMابه همین بنMMد مشMMبرای بزرگ نویسی اولین حرف یا کلمه بن AreaهMMک 

انتخاب های بیشتری غیر از رنگ برای پس زمینه بند فراهم می کند(، گلوله و شماره گذاری.

محاورهٔ
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تورفتگی ها و فاصله گذاری
انبیمشابه تنظیماتی که از نوار ابزار قالب بنMMدی و نوارجMM مشاهده می شود 21همان طور که در شکل 

در اختیار داشتیم در این محاوره نیز در اختیارمان است و البته این مزیت در این محاوره وجMMود دارد
که می توانیم قبل از اعمال، پیش نمایشی شماتیک را مشاهده کنیم.

(Alignmentترازبندی)
 ردیف کردن دیده می شود نیز تنظیماتی مشMاهده22در مورد ترازبندی متن که ترجمه آن در شکل 

می شود که در نوارابزار قالب بندی و نوارجانبی مشاهده کرده بودید.

این محاوره علاوه بر مزیت گفته شده در سربرگ قبلی)مشاهده پیش نمایش( ، این مزیت را دارد که
می توانیم برای خط آخر در تراز دو طرفه هم تعیین تکلیف کنیم. مثلا بخMMواهیم آخMMرین خMMط بنMMد،
وسMMMMط چین باشMMMMد یMMMMا آن هم ماننMMMMد این بنMMMMد، اجبMMMMاراً از دو طMMMMرف تMMMMراز باشMMMMد.
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(Stylesقالب بندی: مستقیم)دستی( یا سبک ها)
دو گونه قالب بندی داریم که در ادامه توضیح داده خواهدشد.

 قالب بندی مستقیم]یا دستی[ 
اعمال قالب بنMMدی بMMه طMMور مسMMتتقیم روی بنMMدهای خMاص، نویسMMه ها، صMMفحات،قاب هMMا،
فهرست ها یا جداول. به عنوان مثال می توانیم کلمه ای را انتخاب کنیم و سپس روی دکمه ای

 کنیم.( کلیکItalic(یا کج)Bold)از نوار قالب بندی، مانند توپر

سبک ها
ه ای از گزینه های قالب بنMMدی تحت عنMMوان یMMک نMMام. بMMه عنMMوان مثMMال، سMMبک بنMMد)بست

paragraph  styleله بینMMدازه آن، فاصMMد قلم، انMMمی تواند شامل تنظیمات معتددی مانن)
فاده کنیم با انتساب آن سبک بMMه بنMMدخطوط و غیره باشد که هرجای که خواستیم از آن است

خاص، همه تنظیمات یک جا اعمال می شود.

استفاده از سبک ها توصیه می شود
 از آنجا که سبک ها مجموعه ای از قالب ها را، همزمان اعمال می کند،  به ما این توانایی را می دهد کMMه
قالب یک سند را منظم کنیم و با کم ترین زحمت، قالب بندی را در تمام سند اعمال کMMنیم. بنMMابراین
استفاده از سبک ها به شدت توصیه می شود. به علاوه این که استفاده از سبک ها قابلیت هایی ماننMMد

فراهم می کند که ممکن است از آن مطلع نباشید.ایجاد خودکار فهرست مطالب را 

 صفحه ای را با نرم افMMزار رایMMتر تMMایپ و صMMفحه آرایی2۰۰فرض کنید که می خواهیم یک کتاب مثلا 
کنیم؛ اگر به صورت معمولی از نرم افزار استفاده کنیم، بعد از تایپ کتاب اگر از ما خواسته شود قلم
یا رنگ بندی عناوین کتاب را تغییر دهیم، نیاز به صرف زمان زیادی دارد. یا اگر بخواهیم فهرسMMتی
از مطالب کتاب به همراه شماره صفحه آن استخراج کنیم، کار طاقت فرسایی است به ویMMژه اگMMر بMMا

تغییر اندازه قلم ها یا اندازه صفحه و...، شماره صفحات تغییر کند.

( استفاده کرده باشیم همه این کار ها)به روزرسانی ها( با یک دستور بهStyleاما اگر از قابلیت سبک )
( یا  چند کلیک ساده انجام می شود.updateروز رسانی)
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اعمال سبک ها به طور آسان و سریع از دسته سبک ها در نوار جانبی امکان پذیر است.

احتیاط

 قالب بندی دستی ] که قالب بنMMدی مسMMتقیم هم خوانMMده می شMMود[، سMMبک ها را رد
ویت اعمال بالاتری دارد، به این معنا که اگر قسمتی را به طورمی کند یا به عبارتی اول

دستی قالب بندی کنیم، هیچ سبکی بر آن قسمت، اعمال نمی شود.

حذف قالب بندی دستی
برای حذف قالب بندی دستی، متن مورد نظر را انتخاب می کنیم و:

 را انتخاب می کنیم یاFormat > Clear Direct Formatting  قالب بندی < از نوار منو •

 را انتخاب می کنیم یاClear Direct Formattingروی آن کلیک راست می کنیم و  •

 روی نوار ابزار قالب بندی، کلیک می کنیم یاClear Direct Formatting شمایل  روییا •

•Ctrl+M.را از صفحه کلید می فشاریم 
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4فصل 
کار با جدول

تقدیم به پدر عزیزم که  آسمانی شد



مقدمه

جداول راه مفیدو کاربردی برای سازماندهی و ارائه مقادیر زیادی از اطلاعات هستند، مثل:

گزارش های فنی،  مالی یا آماری•

صوصیات و تصاویر محصولاتکاتالوگ توضیحات، قیمت ها، خ•

 صورت حساب ها و فاکتورها•

فهرست اسامی با نشانی، سن، حرفه و دیگر اطلاعات•

جدول ها می توانند بیشتر به عنوان جایگزینی برای صفحات گسترده به منظور سازماندهی اطلاعMMات
استفاده شوند. یک جدول خوب طراحی شده می تواند خوانندگان را کمک کند تا بهتر متوجه شMMوند

 که به طMMور معمMMول بMMرای متن یMMا اعMMداد از جMMدول اسMMتفادهر مواقعیکه چه می خواهیم بگوییم. د
می کنیم،  می توانیم دیگر اشیاء از قبیل تصاویر را هم در سلول های جدول قراردهیم.
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ابزارهای کار با جداول

 ( و2۳ در نMMوار منMMو)شMMکل Tableهمه دستورات جدول شرح داده در این فصل به راحتی از منوی 
 ( دیده می شود.2۴نوارابزار جدول)مشابه  شکل

موقعی که جدولی ایجاد می کنیم یا جدول موجودی را انتخاب می کMMنیم، نMوار ابMMزار جMدول )مشMابه
 ( به طور خودکار ظاهر می شود. البته می توانیم هر زمانی که خواستیم آن را بMMا کلیMMک روی2۴شکل

ظاهر کنیم.( View > Toolbars > Tableنما < نوارابزارها < جدول )

 سطربالای سطر خالی ایجاد1
انتخابی

رنگ پس زمینه سلول جدول17

سبک های قالب بندی خودکار18ایجاد سطر خالی پایین سطر انتخابی2
 خالی قبل سطرستون ایجاد3

انتخابی
حاشیه ها19

سبک حاشیه20ایجاد ستون خالی بعد از سطر انتخابی4
رنگ حاشیه21حذف سطرهای انتخابی5
قالب بندی عددی:ارزی22حذف ستون های انتخابی6
قالب بندی عددی: درصد23حذف جدول7
قالب بندی عددی:اعشاری24انتخاب سلول8
قالب عددی25انتخاب جدول9
درج شرح26ادغام سلول ها10
مرتب سازی27تفکیک سلول ها 11

محافظت از تغییر مقدار سلول ها28 جدولتفکیک12
حذف محافظت از تغییر مقدار سلول ها29بهینه سازی اندازه13
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مجموع30تراز از بالا14
فرمول نویسی31وسط عمودی15
مشخصات جدول32تراز از پایین16

 را هم در منوی راست کلیک روی جدول یا پانل جدول دسMMته خصوصMMیاتبزارهای جدولبرخی از ا
 (2۵نوار کناری می توانیم بیابیم)شکل 

ایجاد یک جدول

نتیجه که می خواهیم کمکقبل از ایجاد جدول در یک سند، رایتربه ما برای داشتن ایده ای از ظاهر 
می کند تا برآوردی از  تعداد سطرها و ستون مورد نیاز داشته باشیم. همه مقادیر بعد از ایجMMاد قابMMل
تغییر هستند؛ هر چند از پیش فکر کردن می تواندصرفه زمانی داشMMته باشMMد چراکMMه تغیMMیرات کلی

قالب بندی جداول اغلب زحمت زیادی نیاز دارد.

ایجاد یک جدول جدید
برای ایجاد سرع یک جدول با مشخصMMات پیش فMMرض، روی شMMمایل

Insertدرج ج..دول)  Table ..)کMMتاندارد کلیMMزار اسMMوار ابMMروی ن
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 سMMتونی و پMMانزده سMMطری[ انتخMMاب وده می کنیم.از جدولی که باز می شود اندازه جدول را]حداکثر  
کلیک می کنیم.

برای ایجاد جدول جدید با ویژگی های خاص)تعداد سطر و ستون بیشMMتر و…( نشMMانگر را جMMایی کMMه
می خواهیم جدول ایجاد شود قرار می دهیم و سپس از یکی از راه های زیر محMMاوره درج جMMدول را بMMاز

می کنیم:

  پایین ایجاد سریع جدولMore Optionکلیک روی دکمه ...•

 از نوار منوTable > Insert Tableانتخاب  •

.Ctrl+F12فشردن  •

 نام، می تMMوانیم نMMامی متفMMاوت از نMMامدر کادر (، 2۶ محاورهٔ ایجاد جدول )شکل عمومی قسمتدر 
نویسیم؛ این نام در ناوبری یا پیمایش سند یا در واقع سهولت در شناسMMایی و دسترسMMیپیش فرض  ب

سریع به جدول مورد نظرمان از  بین جداول موجود، مفید واقع می شود.

تعداد ستون ها و سطرهای جدول جدیدمان را مشخص می کنیم کMMه Rows و Columnsدر کادر  
البته در صورت لزوم بعدا می توانیم اندازه و سایر مشخصات جدول را تغییر دهیم.
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در قسمت گزینه ها، مشخصات اولیه جدول را تنظیم می کنیم:

•Headingفعال کردن سرستون داشتن که با آن تصریح می کنیم که اولین یا چندین سطر اول جدولمان –  
 ستون ها(هستند.)سرشناسه یا عنوانسرستون 

•Repeat heading rows on new pagesسطرهایی که سرستون هستند را  در صفحات — 
 بیش از یک صفحه باشدجدولمانبعدی تکرار می کند که بسیار مفید است در مواقعی که 

.Heading rowsدر این قسمت تعداد سطری که سرستون هستند را مشخص می کنیم که به طور طبیعی — 
 است. 1و پیش فرض مقدار آن برابر 

•Don’t split table over pages.جلوگیری از شکسته شدن جدولی که در صفحه جا نمی شود — 
 شود، مفید واقعدیدهاین گزینه می تواند مواقعی که جدول در اواخر صفحه ایجاد شده است و بهتر است کامل و یکجا 

شود به این صورت که اگر ادامه جدول به صفحه بعد  بیفتد،  قسمتی از جدول که در صqqفحه قبqqل بqqوده اسqqت هم بqqه
صفحه بعد منتقل می شود. بدیهی است که اگر جدول با این که یک صفحه کامل را گرفته و باز هم جqqا نمی شqqود چqqه

این گزینه فعال باشد و چه نه ، به ناچار در ادامه شکسته خواهدشد.
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می زنیم. رایMتر یMک جMدول بMMه(.. Insert درج)بعد از تعیین یا انتخاب موارد مورد نظر روی دکمه
پهنای صفحه با ستون ها و سطر های هم اندازه برای ما ایجاد می کندو ما می توانیم در ادامه آن هMMا را

در صورت نیاز تنظیم کنیم.

الب بندی چیدمان جدولق
قالب بندی جدول دو فرآیند دارد؛ یکی قالب بندی چیدمان جدول که موضMMوع همین بخش اسMMت و

دیگری قالب بندی متن جدول که موضوع بخش بعدیست.

قالب بندی معمولا در برگیرنده یک یا چند علمیات است: تنظیم اندازه و موقعیت جدول در صفحه،
تنظیم اندازه سطرها و ستون ها، اضافه یا حذف کردن سطرها یا ستون ها، ادغام یMMا تقسMMیم سMMلول ها،

تغییر حاشیه ها و پس زمینه.

غییر اندازه و موقعیت جدولت
بر اساس تنظیمات پیش  فرض، هر جدول جدیدی که ایجاد می شود تمام عرض ناحیه متن را اشغال
می کند.اما گاهی ترجیح می دهیم جدول ماکوچک تر باشد. برای تغییر اندازه سریع یک جدول، ابتMMدا
موشی را به کناره های چپ یا راست جدول می بریم؛ هنگامی که شکل نشانگر به پیکان دوطرفه تغییر
کرد، حاشیه را به موقعیت می کشیم.این عملیات فقط اندازه اولین یا آخرین ستون را تغییر می دهد و

را ممکن است به هم بزند.  در صفحه جدول)چینش(ترازبندی

وره خصوصیات جMMدول را بMMا انتخMMابابرای کنترل دقیق روی اندازه و موقعیت جدول در صفحه مح
Table Properties یا کلیک راست روی جدول و انتخاب منوی Table > Propertiesمنوی 

 (2۷می کنیم.)شکلباز 
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، می توانیم از طریق راه های زیر ترازبندی (2۷)شکلبرای  ویرایش یک جدول از زبانه جدول محاوره 
جدول را تنظیم کنیم:

تنظیم پیش فرض یک جدول، پر کردن عرض ناحیه متنی(:Automaticخودکار)•

 تراز کردن جدول با حاشیه چپ صفحه(:Leftچپ)•

 تراز کردن جدول با حاشیه چپ صفحه(:Rightراست)•

با تعیین دقیق فاصله جدول از سمت چپ صفحه، اجازه می دهد (:From Leftاز چپ)•
عرض جدولمان بیشتر از ناحیه متنی صفحه  باشد.و حتی  محل قرارگیری آن  تعیین کنیم

(:تراز کردن جدول  بین حاشیه های چپ و راست. به عبارت دیگMMر فاصMMلهCenterوسط)•
جدول از چپ و راست صفحه یکسان خواهدشد.

(: به ما اجازه می دهدفاصMMله از دو سMMمت راسMMت و چپ را در کادرهMMایManualدستی)•
راست  و چپ دقیق و به دلخواه تعیین یا وارد کنیم.
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پهن@@ا)انتخاب گزینه ای غیر از خودکار، باعث فعال شدن کMMادر ،@@ (Properties ویژگی ها)در قسمت
Width .می شود که در آنجا می توانیم اندازه جدول مورد نظرمان را وارد کنیم)

Relativeرا هم می توانیم انتخاب کنیم تا به جای اندازه درصدی از پهنای را وارد کنیم 

دایی برای ج(Below(و پایین)above بالای سر )از کادرهای، (Spacingفاصله گذاری) در قسمت 
جدول از متن استفاده می کنیم.

، رایتر مقادیری راشوددر تغییر اندازه به کمک موشی، هرگاه اندازه جدول کم تر از اندازه ناحیه متنی 
 درج می کند.راست و چپدر کادرهای 

تشخیص جریان متن
 (، ما می توانیم:2۸ از محاوره ویژگی ها)شکلمتن  جریانزبانهدر 

 صفحه یا ستون قرار دهیم) تا پایان صفحه یا ستون متنی چیزی نوشته نشود(. بqqرایشکنندهقبل یا بعد از جدول، یک •
قب>>ل) و گزینqqه هqqای (Columnس>>تون) یا (Pageصفحه)( با Breakاین کار از ترکیب گزینه شکستن) 

Before) یا (بعدAfter)دولqqواهیم جqqنیم) بخqqاستفاده می کنیم. اگر یک شکننده صفحه، قبل جدول درج ک 
 سبک صفحه جدیدی که جدول به آن منتقل می شود را نیز بqqا انتخqqابخواهیم توانستدر صفحه جدید شروع شود(، 
With Page Styleتغییر دهیم و در ضمن می توانیم شماره صفحات را نیز از ابتدا ت  (نظیمreset).کنیم 

 هم می توانیم تاAllow table to split across pages and columnsبا حذف انتخاب   •
نگه داریم؛ کاری کqqه در ایجqqاد جqqدول هم بqqه روش دیگqqری گفتqqهجایی که امکان دارد جدول در یک ستون یا صفحه 

شده بود.

 اجازه نمی دهیمAllow row to break across pages and columnsبا حذف انتخاب  •
این گزینه در حالتی فعال است که گزینه قبلسطر جدول در یک صفحه و بخشی در صفحه دیگر باشد.بخشی از یک 

انتخاب شده باشد.

 برای نگهداشتن جدول به همراه بند بعدی استفاده می کنیم تا اگر ازKeep with next paragraphاز •
شکستن صفحه استفاده کردیم  جدول  و بند بعدی در کنار هم بمانند چه در این صفحه ماندنqد چqqه بqqه صqqفحه بعqqدی

منتقل شدند.

 برای تکرار سرستون های جqqدول یعqqنی تعqqداد سqطر اولی کqqه مشqqخص می کqqنیم درRepeat headingاز  •
ابتدای صفحه های بعد استفاده می کنیم تا جداولمان خواناتر باشد.

  برای تعیین جهت متن در سلول استفاده می کنیم. جهت های قابل انتخاب عبارتنداز:Text orientationاز •
Vertical(، عم		ودی پ		ایین ب		ه ب		الاHorizontalافقی)  (bottom to  top)ایین		ه پ		الا ب		ودی ب		عم ،
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Vertical (top to bottom) (مافوق تنظیمات  از  استفاده  یا   Use superordinate object

settings )یعنی استفاده از تنظیمات پیش فرض جهت متن صفحه

می توانیم چیدمان عمودی متن در سلول های انتخاب شده را در ادامه انتخاب کنیم. متن درون یک سلول می تواند از•
  توضیح داده شد مانند سایر متqون از طqرق دیگqرکه در زبانه جدول محاورهبالا، وسط یا پایین تراز شود. چبدمان افقی 

مانند نوار ابزار قالب بندی امکان پذیر است.

تغییر اندازه سطر ها و ستون ها
ما می توانیم ارتفاع سطر ها و پهنای ستون های یک جدول را به چند روش تنظیم کنیم:

موشی را به لبه سلول حرکت می دهیم، وقتی پیکان دو طرفه ظاهر شد، کلیک می کنیم و دکمه کلیqqک موشqqی را نگqqه•
می داریم و حاشیه را به موقعیت مورد نظرمان جابجا می کنیم و دکمه ماوس را رها می کنیم.

 افقی، ستون ها و روی خط کش عمودی سطرها، با دو خط نازک خاکستری رنگ علامت گqqذاری شqqدهخط کشروی •
اند. ما می توانیم با موشی اندازه یک سطر یا ستون را با نگه داشتن کلیک روی آن علامت ها و جابجا کردن آن، تغیqqیر

دهیم.
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 از نوار منو نیز گزینه هایی برای تغییر اندازه فراهم می کند:Table > Sizeانتخاب 

برای وارد کردن یک اندازه در(	 Row Height  ازتفاع سطر)یا (	 Column Widthعرض ستون)  انتخاب •
(برای سطر و ستون های انتخابی جدول.Sizeکادر اندازه)

 برای کاهش پهنا یا ارتفاعMinimize Row Height یا Minimize Column Widthگزینه های •
سطر و ستون های انتخابی تا حد ممکن است. بدیهی است که با توجه به متفاوت بودن مقدار متن در سطر و ستون

های مختلف،  با این انتخاب اندازه سطر و ستون های مختلف ممکن است با هم یکسان نشوند.

Optimal Row یا ارتفاع بهینه سطر) (Optimal Column Widthگزینه های عرض بهینه ستون)•

Height.براساس بیشترین اندازه متن یا عرض و ارتفاع، اندازه ای بهینه تنظیم می  کند ،) 

برای  (  Distribute Columns/Rows Evenly )از گزینه های توزیع یکنواخت سطرها/ ستون ها•
هم اندازه کردن سطر یا ستون های انتخابی استفاده می کنیم.

از محاوره ویژگی های جدول Columns بیشتر روی اندازه هر ستون، می توانیم از زبانه کنترلبرای 
( مثلا:2۹استفاده کنیم.)شکل 

اجازه دهیم پهنای جqدول مطqابق بqا تغیqیرات مqا در صqورتمی توانیم : Adapt table width با انتخاب  •
 این که پهنای کل جدول را تغییر دهیم اندازه ستون ها را تغیqqیرامکان افزایش یا کاهش یابد و اگر انتخاب نشود بدون

اگqردهیم به این معنا که کوچک تر کردن یک ستون افزایش همزمان پهنqای سqایر سqتون ها را در پی خواهqد داشqت. 
( انتخاب شده باشد این گزینه غیرفعال است.Automaticاندازه جدول خودکار)

   اندازه سایر  ستون ها نqqیز بqqه همqان مقqداری کqqهAdjust columns proportionallyبا انتخاب •
برای یک ستون تغییر می دهیم، همزمان تغییر می کند،از آنجا که افزایش و کاهش همزمان ستون ها بqqدون افqqزایش

و کاهش اندازه جدول ممکن نیست؛ با انتخاب این گزینه، گزینه قبل هم به طور خودکار انتخاب می شود.

•Remaining spaceمقدار باقی مانده تا حاشیه صفحه را نمایش می دهد که در واقع مقداری است پهنای 
جدول در نتیجه افزایش اندازه ستون ها  قابل افزایش است.این مقدار قابل ویرایش نیست، مقدار منفی هم نیست

 حاشیه راست و چپ بوده باشد.از قبل بیشتر از فاصله مگر این که عرض جدول 
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با تنظیم اندازه هر  هر ستون را  به طور جداگانه می توان تنظیم کرد.(،Column widthعرض ستون)در •
کدام از ستون ها برای حفظ اندازه عرض جدول، مابقی مقدار عرض سایر ستون  ها تغییر می کند.

نکته

برای تنظیم اندازه ستون های و سطرهای یک جدول جدید، اغلب موشی  نسبت بMMه
محاوره ویژگی های جMMدول، کMMارایی بیشMMتری دارد و بMMرای تنظیم دقیMMق چیMMدمان از

سربرگ ستون ها و سربرگ جدول در محاروه ویژگی های جدول استفاده می شود.

درج سطرها و ستون ها
برای درج سریع سطر یا ستون، نشانگر موشی را روز سطر یا ستون قبلی یMMا بعMMدی مMMورد نظMMر قMMرار

می دهیم و برای درج سطر یا ستون به یکی از روش های زیر عمل می کنیم:
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یا Rows Above روی شqqمایلبرای درج سطر قبل یا بعد از سطر فعلی، از روی نوارابزار جدول یا نوار کنqqاری، •
Rows Below کلیک می کنیم 

Columnsروی شqqمایل  فعلی، از روی نqqوارابزار جqqدول یqqا نqqوار کنqqاری، سqqتون قبqqل یqqا بعqqد از سqqتونبqqرای درج •

Above  یا Columns Below. کلیک می کنیم 

Tableاز منqqوی  •  >  Insert  >  Rows  Above/Below یا Table  >  Insert  >

Columns Before/After

Insertکلیqqک راسqqت و انتخqqاب  •  >  Rows Above/Below  اqqی Insert  >  Columns

Before/After

برای درج چندین سطر یا ستون:

نشانگر موشی را روی سطر یا ستون مد نظر قرار می دهیم(5

 <  ستون ها…  یا با کلیک راست وTable > Insert یا طرها . . .  < سTable > Insertاز منوی  (6
(  باز می30ستون ها...، پنجره محاوره ای کوچک)مشابه شکل  < Insert یا  سطرها…  < Insertانتخاب  

شود.

  مشخص می کنیمNumberتعداد سطر یا ستون مد نظر را در کادر (۷

( یا  بعد)Abow/Before همچنین موقعیت سطر یا ستون های جدید را  مشخص تایید می کنیم، تا  قبل)(8
Below/After.ایجاد شود )
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نکته

سطر یا ستون های جدید به هر روشی که اضافه شوند، قالب بنMMدی مشMMابه سMMطر و
ستونی که نشانگر موشی در آن قرار دارد را خواهدداشت.

حذف سطر و ستون ها
برای حذف سریع  یک یا چند سطر یا ستون، سطر یا ستون های مورد نظMMر را انتخMMاب و بMMه یکی از

روش های زیر عمل می کنیم:

Deleteشqqمایل  روی •  selected  rows اqqی Delete  selected  columnsوارابزارqqروی ن 
جدول یا پانل جدول نوارکناری کلیک می کنیم.

 را انتخاب می کنیم.ستون <Deleteیا  < سطر Deleteکلیک راست  می کنیم و •

 را انتخاب می کنیم.ستون <Deleteیا  < سطر Delete  ریزمنویTableاز منوی •

ادغام یا تفکیک سلول ها
ادغام سلول ها معمولا برای سطر اول لازم می شود که  سرستون های جدول هستند و برخی مربMMوط

به بیش از یک ستون است.

برای ادغام یک یا چند سلول در یک سلول:

سلول هایی که می خواهیم ادغام شود را انتخاب می کنیم و یکی از راه های زیر را انجام می دهیم:

 را انتخاب می کنیم.(Merge Cells ادغام سلول ها) نوار منو Table از  منوی •

 را انتخاب می کنیم.(Merge Cells ادغام سلول ها)کلیک راست می کنیم و از منویی که باز می شود،•

روی نوارابزار جدول، کلیک می کنیم.( Merge Cells ادغام سلول ها)روی شمایل •

 کلیک( Merge Cells ادغام سلول ها)از قسمت جدول  پانل خصوصیات جدول در نوار کناری روی شمایل •
می کنیم

به این ترتیب همه محتوی سلول ها در یک سلول قرار خواهد گرفت.

برای تفکیک سلول ها نیز چندین راه وجود دارد:
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ابتدا نشانگر موشی را در سلول مورد نظر قرار می دهیم

 را انتخاب می کنیم.(spilt Cells سلول ها )...تفکیک  نوار منو Table از  منوی •

 را انتخاب می کنیم.(split Cells سلول ها)...تفکیک کلیک راست می کنیم و از منویی که باز می شود،•

روی نوارابزار جدول، کلیک می کنیم.( split Cells سلول ها)...تفکیک روی شمایل •

 کلیqqک(> split Cells سلول ها)تفکیک روی شمایل قسمت جدول  پانل خصوصیات جدول در نوار کناری از •
می کنیم

 باز می شود که در آن چگونگی تفکیک را در آن مشخص۳1به این ترتیب محاوره ای مشابه شکل 
می کنیم. یک سلول می تواند افقی)به چند سطر( یا عمودی) به چند ستون( تفکیک شود.

نکته

بهتر است ادغام یا تفکیک سلول ها بعد ازتکمیل قالب بندی و سایر موارد مربوط به
قMMالب بنMMدیچیدمان جدول انجام شود. چراکه ممکن است ادغMMام و تفکیMMک کMMار 

جدول را با سختی مواجه کند.
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مشخص کردن کناره های جدول
کناره ه.ا)ما می توانیم خیلی سریع، تغییراتی روی کناره های جMدول  را بMا اسMتفاده از شMمایل هMای 

Borders (سبک کناره ،)Border Style)(و رنگ کناره Border color)از روی نوارابزار 
از(Borders  کناره ه@@ا)جدول یا پانل جدول نوار کناری اعمال کنیم.برای کنترل بیشMMتر، از سMMربرگ

(استفاده می کنیم.۳2محاوره خصوصیات جدول)شکل 

مان طور که در شکل مشاهده می شود در این محاوره، بودن یا نبودن کناره ها، در سطر ها یا سMMتونه
(،paddingها، سبک، رنگ و ضخامت خط)کناره(، فاصله متن از بالا، پایین، چپ و راست هر سلول)

(، قابل تعیین است.Shadowسایه جدول)، رنگ و موقعیت سبک

انتخاب پس زمینه 
پس زمینه یک جدول می توان بسیار خوانایی جدول را بهبود ببخشد، )مثلا مشخص کردن عنوان ها
و سلول های خاص( یک جذابیت جدول را بیشتر کند.ما می توانیم دو نوع پس زمینMMه بMMرای سMMلول،

سطر یا کل جدول انتخاب کنیم.پس زمینه تک رنگ، پس زمینه گرافیکی.
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ما می توانیم به سرعت با استفاده از جعبه های گزینه ها روی شمایل رنگ پس زمینه سMلول جMدول)
Table Cell Background Colorروی نوارابزار جدول  یا پانل جدول از دسته خصوصیات ) 

.برای کنMMترل بیشMMتر، از سMMربرگنوار کناری، رنگ پس زمینه را روی سلول های جدول اعمال  کنیم
(استفاده می کنیم.۳2از محاوره خصوصیات جدول)شکل پس زمینه 

ایجاد یا اعمال سبک های جدول

برای استفاده از سبک های جدول، ما می توانیم فقط با چند کلیک قالبی را به جدول اعمال کنیم.
شبیه سایر سبک ها، سبک های جدول ما در ثابت نگه داشتن ظاهر جداول در یک سند کمک

می کند.
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اعمال یک سبک جدول
AutoFormatبرای اعمال یک سبک جدول، با کنترل بیش تر،  سبک های قالب بنMMدی خودکMMار  )

Styles را )(از منوی جدولTable روی نوار منو یا شمایل)انتخاب می کنیم. روی نوارابزار جدولآن 
(، از فهرست یMMک قMMالب را انتخMMاب می کMMنیم و  در ادامMMه۳۴در محاوره قالب بندی خودکار)شکل 

ویژگی هایی از قالب  ]مثل قلم، ترازبندی، حاشیه ها و …[ که  می خواهیم بMMه جMMدول اعمMMال شMMود را
مشخص و تایید می کنیم.

نکته

ما می توانیم  قالب بندی که به طور دستی روی یک جMMدول اعمMMال کMMرده ایم را بMMه
قالب های موجود از طریق دکمه افزودن اضافه کنیم.

 ( -سبک هاDefault Table Styleهمچنین می توانیم -غیر از سبک پیش فرض)
(از فهرست حذف کنیم.Deleteرا با کلیک روی دکمه حذف) 

( تغییر دهیم.Rename نام سبک ها را نیز می توانیم با کلیک روی دکمه تغییر نام)
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ترازبندی عمودی
به طور پیش فرض، متن های داخل جدول از سمت چپ و بالای سلول تراز)شروع( می شMMود. البتMMه
می توانیم این پیش فرض را برای همه سلول های جدول یا سلول ها انتخMMابی تغیMMیر دهیم؛ مثلا ممکن

است بخواهیم متن هم از چپ و راست و هم از بالا و پایین در وسط سلول های جدول باشد.

برای تراز کردن عمودی متن در سلول های خاص به ترتیب زیر عمل می کنیم:

نشانگر موشی را در سلول مورد نظر قرار می دهیم یا چندین سلول را انتخاب می کنیم.(1

Align Top, Centerروی یک شمایل از نوار ابراز جدول کلیک می کنیم.)تراز از بالا، از وسط یا از پایین: (2

Verticallyا, ی Align Bottom)

وارد کردن داده و دستکاری آن در جداول

حرکت کردن در میان سلول ها
 بین سMMلول هاTabکلیMMک داخل یک جدول، ما می توانیم با استفاده از موشی، کلیدهای جهMMتی، یMMا 

جابه جا شویم.

با کلیدهای جهتی چپ و راست همان طور که می دانید نشانگر موشی یک نویسه به چپ یMMا راسMMت
جابه جا می شود اما اگر سلول خالی باشد یا نویسه ای باقی نمانده باشد به سلول کناری خواهMMد رفت.

کلید جهتی بالا و پایین هم ما)نشانگر موشی( را به سلول های بالا و پایین می برد.

 هم به طور مستقیم ما را به سلول بعدی حرکت می دهد و اگMMر بMMه آخMMرین سMلول جMدولTabکلید 
 نشMMانگر موشMMی را بMMه سMلول قبلی Shift+Tabرسیده باشیم، سطر جدید ایجاد می کند. فشMردن  

برمی گرداند.

نکته

)پرش یا درج چندین فاصله( استفاده کنیم،Tabاگر بخواهیم از خاصیت عادی کلید 
 می فشاریم.Tab را به همراه Ctrlکلید 
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را می فشMاریم. اگMر سMلول فعMال)سMلولی کMه در آن Ctrl+Homeبرای رفتن به ابتMدای جMدول، 
 ما را به ابتدای سلول می برد و فشMMردن دوبMMاره آن مMMا را بMMه این کلیدمیانبر خالی نباشد (قرارداریم

ابتدای جدول می برد.)فشردن مجدد این کلید چنانچه در ابتدای جدول باشیم ما را به ابتدای سMMند
(منتقل می کند

عملیات بیشتر روی جدول

تفکیک جدول
یک جدول می تواند به دو جدول تفکیک شود و دو جMدول می توانMد در یMک جMدول ادغMام شMود.
جداول به طور افقی قابل تفکیک هستند: سطرهای بالا در یک جدول قرار می گیرد و سطرهای پایین

در جدولی دیگر.

برای تفکیک یک جدول:

 مورد نظر برای جداسازی جدول قراردهید.)سلول های بالا در جدول دیگر قرار خواهد گرفت.سلولنشانگر موشی را در (1

 را انتخاب می کنیم.Split Table  در نوار منو یا شمایل مربوطه روی نوارابزار جدول، Tableاز منوی (2

محاوره تفکیک جدول باز می شود تا در خصوص تصمیم گیری درباره سرستون جدول کمکمان کند.(3

 سرستون جدول تفکیک شده یا بدون سرستون( را انتخاب و تایید می کنیم. در نتیجه جدولرونوشتحالت مورد نظر)(4
به دو جدول جدا شده  با یک بند خالی ، تفکیک می شود.

ادغام جداول
برای ادغام دو جدول:

 باید استفاده کنیم – نه دکمهDeleteابتدا بند یا بندهای بین دو جدول باید حذف شود.)برای انجام این کار از دکمه (1
(-Backspaceپس بر)

یک سلول از جداول را انتخاب می کنیم.(2

 را انتخاب می کنیم.(Merge Table ادغام جدول)  روی نوار منو،Tableاز منوی (3
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حذف جدول
برای حذف یک جدول، از هر یک از راه های زیر می توانیم عمل کنیم:

  را انتخاب می کنیم.Table  در منوی باز شده Deleteروی یک قسمت از جدول کلیک راست می کنیم و از •

  را انتخqqابTable  و سqqپس Delete  در نوار منqqو Tableروی یک قسمت از جدول کلیک می کنیم و از منوی •
می کنیم.

  را از نوارابزار جدول  انتخاب می کنیم.Delete  Table  شمایل روی یک قسمت از جدول کلیک می کنیم و •

 راBackspace یqqا Deleteاز انتهای بند قبل از جدول یا ابتدای بند بعد از جدول را انتخqqاب می کqqنیم و دکمqqه •
می فشاریم.

یادداشت

روش چهارم بند قبل و بعد جدول را نیز ادغام می کند که ممکن اسMMت مطلMMوب مMMا
 بندها را دوباره جدا کنیم.Enterنباشد. بنابراین بعد از حذف می توانیم با فشردن 

رونوشت یک جدول
برای رونوشت یک جدول از قسمتی از جدول به قسمت یا سندی دیگر:

جدول را انتخاب می کنیم.(1

2)Ctrl+C را می فشاریم یا روی شمایل Copy.روی نوار ابزار استاندارد کلیک می کنیم 

جایی که می خواهیم جدول در آن جا رونوشت شود کلیک می کنیم.(3

4)Ctrl+V را می فشاریم یا روی شمایل Paste.روی نوار ابزار استاندارد کلیک می کنیم  

جابه جایی جدول
جدول را انتخاب می کنیم.(1

2)Ctrl+X را می فشاریم یا روی شمایل Cut.روی نوار ابزار استاندارد کلیک می کنیم 

 شود کلیک می کنیم.منتقلجایی که می خواهیم جدول در آن جا (3

4)Ctrl+V را می فشاریم یا روی شمایل Paste.روی نوار ابزار استاندارد کلیک می کنیم  
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یادداشت

Alt+Enterبرای درج بند قبل از جدول به ابتMMدای جMMدول می رویم و بMMا فشMMردن 

بندی قبل از جدول ایجاد خواهدشد. برای درج یک بند بلافاصله پس از جدول نMMیز
 می زنیم.Alt+Enterبه انتهای جدول می رویم و 
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